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Copyright Notice 

Copyright Incorporated 2009. All rights reserved. 

 

Disclaimer  

Incorporated shall not be liable for technical or editorial errors or omissions contained 

herein; nor for incidental or consequential damages resulting from furnishing this 

material, or the performance or use of this product.  

Incorporated reserves the right to change product specifications without notice. 

Information in this document may change without notice. 

 

Trademarks 

Microsoft, Windows XP and VISTA are registered trademarks of the Microsoft 

Corporation. All other brand and product names mentioned herein may be registered 

trademarks of their respective owners. 

Customers should ensure that their use of this product does not infringe upon any 

patent rights. Trademarks mentioned in this publication are sued for identification 

purposes only and are properties of their respective companies. 
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Introduction 

The revolutionary USB Server Hub utilizes technology that streamlines and enhances 

functionalities between USB devices and multiple PCs. Current solutions from other 

companies provide minimum functionalities at high costs. They use significant amounts 

of resources and effort to achieve the required features, whereas the USB Server Hub 

utilizes significantly less resources for more features. Most solutions allow printer-only 

peripheral devices. However, USB Server Hub allows you to use a multifunction combo 

device, such as a printer-scanner or printer-fax all-in-one! Another added benefit is that 

you can connect multiple printers/scanners/faxes to the USB Server Hub. These are just 

some of the features that make our product one of the standards today. The USB 

Server application provides a user friendly interface between you and the USB Server 

Hub, enabling you to monitor, manage and use the convenient and powerful functions 

provided by USB Server Hub.  

Features 

·  Centralized remote USB Server Hub Management 

·  Centralized remote USB Server Hub Status Monitoring 

·  Centralized remote USB Device Management 

·  Centralized remote USB Device Status Monitoring 

 

System Requirement (Suggestion) 

XP System: 
 
CPU: P4 1.7 GHz equivalent or better 
Memory: 512MB or more 
 
 

VISTA System: 
 
CPU: P4 3.0 GHz equivalent or better 
Memory: 1GB or more. 
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Installation 

To install the USB Server Hub program, please double click the USB Server Hub setup 

file. A dialog box should pop up to prompt you to choose desired installing language. 

There are two choices: English and Traditional Chinese. 

 

After choosing the language, click on OK. The InstallationShield Wizard will start 

automatically.  

 

Please follow the instructions of the wizard to complete the installation process. 

 

Please reboot the system as requested by the instal ler when the process ends, 

otherwise the software might not work properly. 
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Running Program 

To start the USB Server Hub program, please double click the shortcut icon of the USB 

Server Hub on the Desktop. 

 

 

This brings up the main dialog. 
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Main Dialog Box  

 

 

The main dialog box of USB Server  Hub is shown above. This is what you would see at 

program start up. It is consisted of a Control Menu (File, View and Help), a tree view, a 

Search  button to get the current status of all USB Servers and devices on the network, 

and a button that toggles between “Config.” and “Connect” depending on the node you 

select on the tree view. It toggles to “Config.” when a server is selected on the tree view 

and to “Connect” when a device is selected. The tree view displays the all the USB 

Servers and devices your PC has access to.  
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Note: You will be allowed to set an alias name for each of the servers on for easy recognition. The 

alias name with its IP address will be displayed on  the tree view. The way to set alias name will be 

described in the “Config.” section below. 

Status of USB Servers and Devices 
 
The tree view also tells you the status of all the USB Servers and devices that are 

accessible to you. Each of USB Server is either accessible or inaccessible. An 

inaccessible server is either disconnected from the network, powered off or suffers other 

technical difficulties that prevent it from being accessed by your PC. Inaccessible server 

will not show up on the tree view.  

 

However, the devices have several kinds of demonstrated status: 
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Ready 

 

Each status is represented by an icon of different color. A device with “Ready” status is 

indicated by a square Green icon as shown in the picture above. This green icon 

indicates that the device is unoccupied and ready to be connected.  
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Occupied by Yourself 

 

When you are “Connected ” to a device, the green icon turns into an Orange  icon to 

signify the establishment of the connection. 
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Occupied By Other User 

 

The Red icon indicates the device is occupied by another user  and you can not 

connect to that device at the moment. 
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: Device on Different Segment 

Blue icon indicates that the server’s IP address is on a different network segment as 

from yours. You can NOT connect to a device attached to such server. 

 

: Unsupported Device 

Some of the devices are not supported by USB server Hub. Such device will be 

identified by a red X icon. Of course, connecting to an unsupported device is not 

allowed. 

 

: Self Occupied with Error 

When an error happens on the device you are connected to, you will see a small 

exclamation mark appears at the right lower corner of the icon as show above. This 

problem could be that the device is a printer and it is out of ink or out of paper.  

 

: Occupied by Others with Error  

When you see this red-with-exclamation icon, it signifies that a problem occurs on the 

device that is occupied by another user.  

 

: Free with Error 

A green icon with exclamation mark indicates that this device is not connected by 

anyone but does have some type of problem such as out of ink.  

 

Of course, any problem indicated by the exclamation  mark would prevent the 

device from working properly. Please resolve the pr oblem before you continue 

using the device.  
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Accessing a Device 

 

 

To connect to a USB device, please select it on the tree view and click on “Connect”  

button or double-click on it. This process might take a few seconds up to a minute, 

depending on the complexity of the device.  

Once connected, you can use the USB device as if it  is connected to your PC 

directly with a USB cable. 
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If you select a connected device on the UI, you can see that the Connect button is 

changed to Disconnect : 

 

 

Clicking on the button disconnects you from the selected device. Once you see the icon 

turns green, the device has been disconnected and other users will then be able to 

connect to it. 
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Server Configuration 

 

We allow the users to configure the settings of the USB Servers via the web-based UI. 

Select the target server on the tree view and then click on the “Config.” button or right 

click on the server and select “Config” option on menu to bring up this configuration UI. 
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Configuration with Web-based UI 
 

Your default web browser will pop up and take you into the web-based configuration UI 

of the server. 
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This is the main page of the configuration UI. You can see the important information 

about the USB Server and the device(s) connected to it. The 6 links at the left-hand side 

each represents a function. Clicking on “Device Status” brings you back to this page, 

and the 5 other links take you to pages with different functions. 

Network Information/Setting 

 

This page displays the current network setting of the server and provides links to the 

pages where you can perform special actions. You can change the network setting 
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according to your need. However, please note that if you would like to give this 

server a static IP, please disable the DHCP option . Once you are done, please click 

on the “Submit” button and reboot the server. 

NOTE: A Server with busy device(s) connected is pro hibited to be configured to prevent 

interruption of any on-going tasks. 
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Server Reset 

Clicking on this link takes you the page show below: 

 

With the “Reset Server” button you can reboot the server. However, if there is a 

password, you must enter it for this function to work. Password is by default blank. So, 

unless a password is explicitly set, you do not have to enter anything for the reset 

function to work. 
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Factory Default 

Clicking on this link takes you the page where you can restore the server’s settings back 

to default: 
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Again, the password is not necessary if no password is set. Just leave the field empty 

and click on the “Factory Default” button to restore the factory default settings. 
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Update Firmware 

This link takes to the page where you will be able to upload the latest firmware for the 

server: 

 

Please first click on the “Browse” button to browse to the firmware you would like to 

upload and then click on the “Submit” button to update the firmware. You do not need to 
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provide a password for this operation if there is not password set. Please just leave it 

blank. 

 

Change Password 

Clicking on this link takes you to the password update page below: 

 



 USB Server Hub User Manual 
 

 
DOC NO: ED-201-001                                                                                                       - 24 - 
REV: v.1.0 

To change the password, you must enter current password, input new password and re-

input new password for confirmation and then click on “Submit”. If you are setting the 

password for the first time, you don’t have to provide current password. 
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Configuration with the Utility 
 

Another way to configure the server is via the configuration dialog of PB2. To bring up 

the configuration dialog, please RIGHT-CLICK on the server you would like to configure, 

 

And select the “Setting” option. If a protective password has been set, this option brings 

up the following configuration dialog. 
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You might be prompted to enter password if a password has been set. If not, you will 

immediately see the above dialog. 

 

Set Sever Name and IP Address: these fields allow you set the server name and IP 

address settings. If you are changing IP address, please make sure you know what you 

are doing. 

 

NOTE: You can apply this function to a server under  different network segment.  
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Backup Firmware: this function is a fail-save mechanism for the Update Firmware 

function.  

 

Use the Browse  button to choose where you want to save the backup file. Click on 

Submit  to start. You can backup the current firmware of your server and save it on your 

PC in case you updated the latest firmware and want to revert back for some reasons. 

 

Update Firmware: update firmware with this function. 

 

Use the Browse  button to choose the firmware to update. Click on Submit  to start. 

 

Change Password: Simply enter the new password and enter it again for confirmation. 

Click on Submit  to change. 
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Reset Server  

This button reboots the server. Please note that this function will not work if the server 

you attempt to reset has a device connected to it and the device is occupied by a user. 
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Polling Interval 

The USB Server Hub  program periodically polls your network to find out the status of 

all the connected servers and devices. Any change on the status of servers and devices 

will be updated to the tree view in the main dialog box. The default setting is that the 

program would perform this polling every 30 seconds. To change this polling interval, 

click on the File -> Settings -> Polling Interval  option on the control menu: 

 

Then you should see this dialog box pops up: 
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As indicated on this dialog box, you must input a minimum of 20 seconds. Set it to 0 to 

disable this function. Click on Submit  to allow the new interval to take effect. 
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Language 

USB Server Hub now supports two languages: English and Traditional Chinese. To 

toggle between the languages, please go to File -> Settings -> Languages option and 

select the desired language. 

 

Simply select the desired language to change the UI’s displaying language. 



 USB Server Hub User Manual 
 

 
DOC NO: ED-201-001                                                                                                       - 32 - 
REV: v.1.0 

Search 

When you are in need of knowing the status of all the servers and devices immediately, 

use the Search function:  

 

Clicking on the “Search” button triggers the program to immediately poll the network for 

the status of all the servers and devices. The result will be updated to the tree view. 
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View 

The tree view in the main dialog has two display modes: “Servers and Devices” mode 

and “Devices Only” mode. The default setting is “Devices Only” mode. You can toggle 

between these two display modes with the View option on the control menu: 

 

Servers and Devices view 
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Devices Only view 
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Device Details 

When you right click on a device on the tree view, a menu will pop up: 

 

When you select the “Details” options, some detailed information about the selected 

server/device respectively will be displayed in another pop-up dialog box. 
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Help -> About 

 

About  option brings up a dialog box with legal and other relative information displayed: 



 USB Server Hub User Manual 
 

 
DOC NO: ED-201-001                                                                                                       - 38 - 
REV: v.1.0 

 

Technical Support 

If you have any questions that the Troubleshooting section failed to address, please visit 

your dealer for further help. We have Technical Support working non-stop in order to 

provide the best support we can for our customers. 

 

  


